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KATA PENGANTAR 

 

Puji syukur penulis panjatkan kehadirat Tuhan Yang Maha Esa, yang telah 

memberikan karunia–Nya kepada kami untuk dapat menyelesaikan Praktik 

Pengalaman Lapangan (PPL) UNY yang telah terlaksana dari tanggal 03 Juli 2014 

sampai 17 September 2014 di UPTD Sanggar Kegiatan Belajar (SKB) Kabupaten 

Sleman dan dapat menyelesaikan laporan PPL ini dengan lancar dan sukses. 

Penulis menyadari sepenuhnya bahwa pelaksanaan kegiatan Praktik 

Pengalaman Lapangan (PPL), tentunya tanpa bantuan semua pihak program-program 

yang kami susun tidak akan terlaksana dengan baik, Oleh karena itu penulis 

mengucapkan terima kasih atas bantuan yang bersifat moril maupun materiil. Kami 

mengucapkan terimakasih kepada: 

1. Orang tua yang telah memberikan dukungan moral maupun material. 

2. Dr. Rochmat Wahab, M. Pd, MA, selaku rektor UNY yang telah memberikan 

kesempatan untuk pelaksanaan kegiatan KKN-PPL UNY 

3. Tim Lembaga Pengabdian Masyarakat (LPM) UNY yang telah memberikan 

bimbingan dan pengarahan selama pelaksanaan PPL sampai penyusunan laporan 

ini.  

4. Dr. Sujarwo, M.Pd selaku Dosen Pembimbing Lapangan (DPL) yang selalu 

memberikan bimbingan dan pengarahan selama pelaksanaan PPL sampai 

penyusunan laporan ini. 

5. Bapak-Ibu pamong belajar Sanggar Kegiatan Belajar (SKB) Kabupaten Sleman, 

yang selalu memberikan arahan, masukan dan bimbingan selama pelaksanaan 

PPL. 

6. Ibu-Ibu pendidik PAUD dan KB binaan SKB Sleman, yang senantiasa 

memberikan waktu dan bimbingannya dalam kegiatan pembelajaran. 

7. Rekan-rekan KKN-PPL yang dengan kebersamaan dan persahabatan serta cinta 

sehingga semua tugas dan tanggung jawab dapat kita selesaikan bersama dan tidak 

akan kami lupakan kebersamaan ini selamanya. 

8. Semua pihak yang tidak bisa disebutkan satu persatu yang telah membantu 

kelancaran program kerja PPL dan penyusunan laporan PPL di Sanggar Kegiatan 

Belajar (SKB) Kabupaten Sleman. 

 

Selain itu kami juga mohon maaf dan mengucapkan terima kasih kepada 

semua pihak yang telah membantu pelaksanaan program-program kami. Kiranya 

tidak banyak yang dapat kami lakukan, besar harapan kami, seluruh kegiatan kami 

selama dua setengah bulan dapat bermanfaat bagi lembaga SKB Kabupaten Sleman 

sampai terselesaikannya laporan akhir ini. 

Apabila terdapat kekurangan dalam pelaksanaan program-program yang kami 

laksanakan dalam program PPL, kami memohon maaf kepada semua pihak. Semoga 



laporan ini dapat bermanfaat bagi pelaksanaan PPL berikutnya khususnya bagi 

lembaga SKB Kabupaten Sleman. 

 

Sleman, 19 September 2014 

 

Penyusun 
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ABSTRAK 

 

Praktik Pengalaman Lapangan (PPL) merupakan kegiatan yang terkait dengan 

proses pembelajaran maupun kegiatan yang mendukung berlangsungnya 

pembelajaran. PPL diharapkan dapat memberikan pengalaman belajar, terutama 

dalam hal pengalaman mengajar, memperluas wawasan, pelatihan dan 

pengembengan kompetensi yang diperlukan dalam bidangnya, peningkatan 

keterampilan, kemandirian, tanggung jawab, dan kemampuan dalam memecahkan 

masalah. Praktik mengajar yang dilaksanakan oleh praktikan secara bergantian 

dengan rekan mahasiswa yang lain. Jadwal diatur sedemikian rupa sehingga semua 

rekan-rekan mahasiswa dapat melakukan kegiatan praktik mengajar di semua 

potensi pembelajaran tersebut sesuai kemampuannya masing-masing. Praktikan 

melaksanakan praktik mengajar terbimbing selama rentang waktu PPL berlangsung, 

namun praktik mengajar mandiri hanya dilakukan beberapa kali karena keterbatasan 

waktu dan kemampuan yang ada. Program-program yang dilaksanakan 

menyesuaikan dengan identifikasi kebutuhan yang telah dilakukan sebelumnya saat 

observasi dan menyesuaikan dengan waktu yang telah ditentukan bersam dengan 

pihak-pihak yang terlibat dalam program. Program dapat berjalan lancar tetapi 

tidak lepas dengan faktor pendukung dan faktor penghambat selama program 

dilaksanakan, adapun program yang terlaksana meliputi program Pendampingan : 

(a) Pendampingan TPA, TK, KB, Tunas Harapan dan KB Miftahul Jannah, (b) 

Pendampingan Diklat Tingkat Dasar PAUD, (c) Pendampingan Kursus Manaemen 

Rumah Tangga. Program Kelompok dan Individu tambahan antara lain : (a) 

Penataan perpustakaan SKB, (b) Penghijauan SKB, (c) Open House SKB, (d) 

Syawalan SKB, (e) Mural SKB, (f) Mural KB Miftahul Jannah, (g) Pelatihan 

Komputer Dasar Paket C, dan (h) September Ceria. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



BAB I 

PENDAHULUAN 

 

A. Analisis Situasi 

Kelompok PPL UNY bertempat di SKB Kabupaten Sleman sebagai UPTD 

Dinas Pendidikan dan Kebudayaan yang merupakan salah satu lembaga PLS 

yang mempunyai tugas pokok melakukan pembuatan percontohan serta 

pengendali mutu program pendidikan luar sekolah, pemuda, olahraga, 

kebudayaan berdasarkan kebijakan Dinas Pendidikan dan Kebudayaan. 

Pada awalnya merupakan gabungan dari 2 Sanggar Kegiatan Belajar yaitu 

SKB Sleman yang berkantor di Beran Tridadi Sleman yang wilayah kerjanya 

meliputi wilayah Sleman Barat serta sebagian wilayah Sleman Tengah, dan SKB 

Berbah yang wilayah kerjanya meliputi wilayah Sleman Timur serta sebagian 

wilayah Sleman Tengah. SKB Sleman pada awalnya adalah Pusat Latihan 

Pendidikan Masyarakat (PLPM) sedang SKB Berbah pada mulanya adalah Panti 

Kegiatan Belajar (PKB). 

Sejalan dengan era otonomi daerah yang diatur dalam Undang – Undang 

Nomor 22 Tahun 1999, Pemerintah Daerah Kabupaten Sleman mengambil 

kebijakan menggabungkan SKB Sleman dan SKB Berbah menjadi satu sebagai 

salah satu Unit Pelaksana Teknis Dinas Pendidikan, Pemuda dan Olahraga Kab. 

Sleman yang berkedudukan dibawah dan bertangungjawab kepada kepala Dinas 

melalui Sekretaris SKB, mempunyai tugas melaksanakan sebagian tugas teknis 

Dinas Pendidikan, Pemuda dan Olahraga dibidang pelatihan fasilitator 

pendidikan nonformal, informal, kepemudaan dan keolahragaan. 

Berdasarkan hasil observasi diperoleh informasi mengenai kondisi fisik 

maupun non fisik SKB Sleman yang dapat dijadikan sebagai pedoman awal 

pelaksanaan kegiatan PPL sebagai berikut: 

1. Gambaran Umum Lembaga  

SKB Sleman memiliki sarana prasarana penunjang kegiatan belajar 

mengajar yang sangat lengkap. Adapun secara garis besar dapat diuraikan 

sebagai berikut: 

a. Sarana Dan Prasarana  

Nama Lembaga  : UPT SKB Sleman 

Kode Lokasi      :  

 

No 

Urut 
Jenis Barang 

Kondisi 

bangunan 

B, KB, RB 

Kontruksi 

Bertingkat/ 

Tidak 

Status 

Tanah 

1. Bangunan Gedung kantor 

TU 

B Tidak  Hak Pakai 



2. Bangun Gedung Kantor 

Kepala SKB 

B Tidak Hak Pakai 

3. Bangunan Gedung Kantor 

Pamong 

B Tidak  Hak Pakai 

4. Bangunan Gedung Ruang 

Komputer 

B Tidak Hal Pakai 

5. Ruang Ketrampilan 

Menjahit 

B Tidak  Hak Pakai 

6. Ruang Belajar  Paket B Tidak Hak Pakai 

7. Bangunan Aula B Tidak Hak Pakai 

8 Ruang Tamu B Tidak Hak Pakai 

9 Kamar mandi B Tidak Hak Pakai 

10 Lab Bahasa KB Tidak Hak Pakai 

11 Tanah Pekarangan B Tidak Hak Pakai 

12 Dapur B Tidak Hak Pakai 

13 Perpustakaan B Tidak Hak Pakai 

14 Ruang TPA B Tidak Hak Pakai 

15 Ruang Kelas PAUD B Tidak Hak Pakai 

16 Ruang Kantor Guru PAUD B Tidak Hak Pakai 

17 Ruang Kelas TK B Tidak Hak Pakai 

 

b. Program SKB Sleman 

Sanggar Kegiatan Belajar (SKB) menjadi lahan seluruh kegiatan 

kemasyarakatan dengan berbagai karakteristik dan potensi masyarakat yang 

menjadikan mereka warga belajar. Program-program yang ada di SKB 

berupaya untuk mengembangkan sumber daya manusia dan potensi yang 

dimiliki: 

1) Program Kesetaraan (Paket B dan C) 

Pembelajaran Program Kesetaraan Paket A, B dan C dilaksanakan 

setiap hari selasa dan kamis dengan total siswa paket A adalah 3 peserta 

didik, paket B adalah 4 peserta didik, dan paket C adalah 20 peserta didik. 

2) Taman Penitipan Anak (TPA) Tunas Harapan 

Taman Penitipan Anak menjadi program baru ditahun 2012, dengan 

bantuan para pendidik KB Tunas Harapan yang sama-sama menjadi 

binaan SKB. TPA Tunas Harapan telah memiliki 19 peserta didik dengan 

3 pengasuh. 

 

 

 

 



3) Kelompok Bermain (KB) Binaan SKB 

SKB Kabupaten Sleman memiliki 4 KB/ PAUD binaan yang 

tersebar diseluruh daerah kabupaten Sleman, antara lain: 

 KB Tunas Harapan  

Terletak di SKB Jl. Kalitirto, Berbah dengan jumlah peserta didik 45 

dan 3 pendidik. 

 KB Tunas Bangsa  

Terletak di Ngasem, Kalasan dengan 20 peserta didik dan 3 pendidik.  

 KB Among Putro 

Terletak di Jangkang, Widodomartani, Ngemplak, Sleman. Jumlah 

peserta didik 32 yang didampingi 5 pendidik. 

 Miftahul Jannah  

Terletak di Mbrongkol, Argomulyo, Cangkringan, Sleman. Memiliki 8 

peserta didik dan 3 pendidik. 

4) Taman Kanak-kanak (TK) Tunas Harapan 

Taman Kanak-kanak (TK) menjadi program baru ditahun 2014, 

dengan bantuan para pendidik KB Tunas Harapan yang sama-sama 

menjadi binaan SKB. TK Tunas Harapan telah memiliki 8 peserta didik 

dengan 1 pendidik. 

2. Potensi Kelembagaan 

UPT SKB Sleman dipimpin oleh seorang kepala lembaga dengan delapan 

pamong belajar dan seorang kepala bagian TU. Adapun susunan 

kepengurusan UPT SKB Sleman.  

a) Kepala SKB 

No Nama NIP L/P 

1 Drs. Yunaidi 196205281986021004 L 

 

b) Petugas Tata Usaha 

No Nama NIP L/P 

1 Isworo KDA, S.Pd 196108071992022007 L 

2 Gayatri 196108071992032007 P 

 

c) Jabatan Fungsional 

No Nama NIP L/P 

1 Drs. Sukarja 196109111991031004 L 

2 Mayang Sutrisno, S.Pd 196702141998021003 L 

3 Antonius Sutrisno, SP 197207241998021002 L 

4 Ediyanto, S.Pd 196806    1998021002 L 

5 Lilik Umiyati 196204161997032003 P 

6 Dwi Lestariningsih 197006241998022001 P 



7 Drs. Sri Astuti 196408151998022001 P 

8 Ida Sumiarsih, S.Pd 196901201997022001 P 

 

d) Kinerja  

Pamong belajar dalam pelaksanaan kegiatan untuk beberapa program 

pendidikan luar sekolah di UPT SKB Sleman cukup baik. Hal tersebut 

dapat dilihat dengan terprogramnya seluruh rangkaian kegiatan yang 

dilaksanakan baik di wilayah SKB maupun di daerah binaan SKB.  

Nampak pula dari kelengkapan peralatan dan perlengkapan pembelajaran 

yang dimiliki pamong belajar seperti silabus, RPP, dan modul 

pembelajaran yang menunjukkan perencanan pembelajaran dan kegiatan 

yang sistematis.  

 

B. Perumusan Program Kegiatan 

Perumusan program dan rancangan kegiatan PPL di UPTD SKB Sleman 

Kabupaten Sleman dilakukan berdasarkan hasil observasi yang meliputi potensi 

fisik, potensi sumber daya yang ada di lokasi PPL. Rumusan masalah yang 

dimunculkan dalam kegiatan PPL berupa  pendampingan TPA/KB (Kelompok 

Bermain) dan Pelatihan Kecakapan Hidup (Lifeskill) serta Pengajaran Paket A, 

B, dan C. Adapun hal-hal yang menjadi pertimbangan dalam penyusunan 

program antara lain: 

1. Proses pembelajaran 

2. Tempat dan waktu pembelajaran 

3. Tingkat ketercapaian hasil pembelajaran 

4. Faktor pendorong dan penghambat 

5. Permasalahan yang dialami 

6. Upaya untuk mengatasi permasalahan 

Berdasarkan hasil observasi dan pertimbangan di atas, maka disusun 

program individu yang dilaksanakan mahasiswa selama melakukan PPL. 

Program-program tersebut antara lain: 

 

1. Program Pendampingan 

a. Pendampingan TPA Tunas Harapan, TK Tunas Harapan, KB Tunas 

Harapan, dan KB Miftahul Jannah 

b. Pendampingan Diklat Berjenjang Tingkat Dasar Pendidik PAUD 

c. Pendampingan Kursus Manajemen Rumah Tangga 

 

2. Program PPL Kelompok dan Individu Tambahan 

a. Penataan Perpustakaan SKB 

b. Penghijauan SKB 



c. Open House SKB 

d. Syawalan SKB 

e. Mural SKB 

f. Mural KB Miftahul Jannah 

g. Pelatihan Komputer Dasar Paket C 

h. September Ceria dan Perpisahan 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



BAB II 

PERSIAPAN, PELAKSANAAN DAN ANALISIS HASIL 

 

A. Persiapan 

Praktik Pengalaman Lapangan (PPL) merupakan kegiatan yang dilakukan 

mahasiswa bersifat pembelajaran maupun kegiatan yang mendukung 

berlangsungnya pembelajaran. PPL diharapkan dapat memberikan pengalaman 

mengajar, memperluas wawasan, pelatihan dan pengembangan kompetensi dalam 

meningkatkan keterampilan, kemandirian, tanggung jawab, dan kemampuan dalam 

dalam diri mahasiswa. Adapun hal-hal yang perlu dipersiapkan sebelum 

melakukan PPL adalah sebagai berikut. : 

1. Persiapan di Kampus 

a. Pembekalan 

Pembekalan PPL merupakan salah satu kegiatan yang dilakukan oleh 

pihak LPPMP sebagai lembaga yang menangani program PPL di Universitas 

Negeri Yogyakarta melalui Dosen Pembimbing Lapangan/ DPL yaitu bapak 

Dr. Sujarwo, M.Pd Pembekalan ini dilaksanakan untuk PPL. Adapun materi 

yang diberikan mengenai berbagai macam hal yang seharusnya dilakukan 

oleh mahasiswa pada saat dan sebelum waktu pelaksanaan dan pasca PPL 

berlagsung. 

Pembekalan PPL merupakan upaya untuk mempersiapkan mahasiswa 

secara matang agar dapat melaksanakan kegiatan PPL di lapangan dengan 

baik dan lancer, sehingga pelaksanaan kegiatan PPL dapat mencapai tujuan 

dan sasaran yang sesuai seperti diharapkan. Adapun tujuan dari pembekalan 

PPL ini adalah: 

1) Agar mahasiswa mengerti dan menghayati tentang maksud dan tujuan 

diadakannya program PPL. 

2) Mahasiswa memperoleh bekal secara teknis tentang cara menjadi 

pendidik di masyarakat. 

3) Mahasiswa memiliki keterampilan praktis yang dibutuhhkan oleh warga 

masyarakat di lokasi PPL. 

4) Mahasiswa memperoleh informasi tentang kondisi wilayah dan 

permasalahan di daerah lokasi PPL. 

5) Mahasiswa dapat melaksanakan kegiatan PPL secara terencana dan 

terprogram dan dapat menyusun laporan dengan baik 

Jadwal pelaksanaan pembekalan PPL tahun 2014 sebagai berikut: 

Tanggal  : 25 Februari 2014 

Waktu  : 13.00 WIB - selesai 

Tempat  : Laboratorium, PLS 

Narasumber PPL : Dr. Sujarwo, M.Pd 



b. Microteaching 

Pengajaran microteaching bertujuan untuk membentuk dan 

mengembangkan kompetensi dasar mengajar sebagai bekal praktek mengajar 

di masyarakat dalam program PPL. Oleh karena itu mahasiswa dipersiapkan 

menjadi tutor di semua program PLS. Secara khusus tujuan pengajaran 

micro adalah sebagai berikut: 

1) Memahami dasar-dasar micro 

2) Melatih mahasiswa menyusun RPP (Rencana Pelaksanaan Pembelajaran)  

3) Membentuk dan meningkatkan kompetensi dasar 

4) Membentuk kompetensi sosial 

Jadwal micro teaching: 

Tanggal  : Maret – Mei 2014 

Hari   : Senin dan Rabu 

Waktu  : 13.00 – 15.00 WIB 

Tempat  : Laboraturium PLS 

Pembimbing  : Dr. Sujarwo, M.Pd 

 

2. Persiapan di lapangan 

a. Penyerahan mahasiswa 

Mahasiswa KKN-PLS FIP UNY tahun 2014 berjumlah 13 orang yang 

kemudian oleh dosen pembimbing lapangan diserahkan kepada Kepala SKB 

Sleman Kab. Sleman selaku mitra kerja PLS FIP UNY, yang selanjutnya 

mahasiswa KKN menjadi tanggung jawab pihak SKB Sleman Kab. Sleman 

untuk mendapatkan bimbingan dan pengarahan selama kegiatan PPL yang 

dilaksanakan dalam waktu kurang lebih 2,5 bulan. Adapun penyerahan 

mahasiswa PPL-PLS FIP UNY 2014 dilaksanakan pada : 

Tanggal  :  2 Februari 2014 

Waktu  : 09.00 WIB- selesai 

Tempat  : Ruang Kelas Paket C SKB Sleman 

Narasumber PPL  : Dr. Sujarwo, M.Pd  

  Drs. Yunaidi 

  Drs. Sukarja 

b. Observasi lapangan  

Observasi lapangan dilakukan agar mahasiswa PPL memperoleh data 

yang lengkap dan jelas terkait dengan kondisi lokasi PPL. Observasi 

lapangan ini meliputi kondisi fisik, sarana dan prasarana, kegiatan yang ada 

di lokasi untuk program PPL. Untuk program PPL yang pada saat ini lebih 

diarahkan untuk program KB (kelompok bermain),TPA (tempat penitipan 

anak) TK (Taman Kanak-kanak) dan kesetaraan paket A B dan C, 

melakukan serangkaian kegiatan yang terbagi menjadi tiga tahapan, yang 



pertama adalah tahapan persiapan berupa kegiatan identifikasi warga belajar 

dan persiapan pelaksanaan.Tahap kedua adalah pelaksanaan dan tahap ketiga 

adalah evaluasi dan tindak lanjut. 

c. Rumusan Program PPL 

Tahapan berikutnya adalah merumuskan program PPL yang akan 

dilaksanakan. Dalam merumuskan program PPL juga tidak lepas dari adanya 

kebutuhan dari peserta didik dan tidak merupakan satu kesatuan dengan 

program KKN dikarenakan cakupan wilayah KKN yang berbeda desa 

dengan SKB.Sehingga kegiatan PPL dilaksanakan untuk kegiatan 

pembelajaran saja. 

d. Pembuatan RPP 

Membuat RPP (Rencana Pelaksanaan Pembelajaran) merupakan tahap 

persiapan yang harus dilakukan.Hal ini dikarenakan RPP sebagai acuan 

dalam melaksanakan kegiatan PPL.Selain itu, untuk menyempurnakan RPP 

tersebut dilakukan konsultasi dengan pembimbing PPL. 

e. Persiapan Pra Program 

Setelah melalui beberapa tahapan persiapan yang telah dijabarkan di 

atas, maka tahapan persiapan terakhir adalah persiapan pra program atau 

persiapan sebelum program itu dilaksanakan. Biasanya persiapan ini berupa 

persiapan teknis guna memenuhi kebutuhan pelaksanaan kegiatan PPL. 

Termasuk di dalamnya adalah mempersiapkan ruangan atau membersihkan 

ruangan serta mempersiapkan alat dan bahan yang akan digunakan untuk 

pelaksanaan PPL. 

f.  Penerjunan ke Lapangan 

Mahasiswa PPL-PLS FIP UNY tahun 2014 oleh dosen pembimbing 

lapangan diterjunkan kepada Kepala SKB Sleman Kab. Sleman selaku mitra 

kerja PLS FIP UNY, yang selanjutnya mahasiswa PPL menjadi tanggung 

jawab pihak SKB Sleman Kab. Sleman untuk mendapatkan bimbingan dan 

pengarahan selama kegiatan PPL yang dilaksanakan dalam waktu kurang 

lebih 2,5 bulan. Penerjunan mahasiswa PPL-PLS FIP UNY 2014 

dilaksanakan pada : 

Tanggal   : 2 Juli 2014 

Waktu   : 08.00 WIB - selesai 

Tempat   : Ruang Paket C SKB Sleman 

Nara sumber KKN-PPL : Drs. Sukarja 

 

 

 

 

 



B. Pelaksanaan Program 

Dari penyusunan rancangan program kerja, tidak semua rencana dan 

pelaksanaan terlaksana tepat sesuai dengan yang sudah direncanakan. Hal ini 

dikarenakan adanya faktor-faktor yang dapat berasal dari mahasiswa atau lembaga. 

Berikut ini adalah program PPL yang telah dilaksanakan: 

 

1. Program Pendampingan  

 TPA/ KB/ TK Binaan SKB Kab. Sleman 

No. ITEM PENJELASAN 

1 Nama Kegiatan Pendampingan TPA/ KB/ TK SKB Kab. Sleman 

2 Tujuan Kegiatan Membantu keberlangsungan pendampingan TPA/ 

KB/ TK Binaan Kab. Sleman 

3 Bentuk Kegiatan Proses pendampingan di lingkungan TPA/ KB/ TK 

Binaan Kab. Sleman 

4 Sasaran Kegiatan Peserta didik TPA/ KB/ TK Binaan SKB Sleman 

5 Tempat Kegiatan a. Tempat Penitipan Anak (TPA) Tunas Harapan 

b. KB Tunas Harapan 

c. KB Miftahul Jannah 

d. TK Tunas Harapan 

6 Waktu Kegiatan 03 Juli 2014 s.d 08 September 2014 

Setiap Hari Senin – jumat sesuai dinas kantor SKB. 

7 Hasil Kegiatan Peserta didik dapat berinteraksi dengan teman 

sebaya dan ibu guru di lingkungan TPA/ KB/ TK.  

8 Biaya Kegiatan - 

9 Faktor Pendukung Kelengkapan Alat Permainan Edukatif (APE) dan 

alat bermain membuat anak merasa nyaman saat 

mengikuti proses pembelajaran. 

10 Faktor Penghambat Orang tua siswa yang masih menunggu dan ikut 

dalam proses pembelajaran membuat anak tidak 

berkonsentrasi dalam proses pembelajaran.  

11 Jumlah Jam 121 Jam 

 



 Diklat Berjenjang Tingkat Dasar Pendidik PAUD 

No. ITEM PENJELASAN 

1 Nama Kegiatan Pendampingan Diklat Berjenjang Tingkat Dasar 

Pendidik PAUD 

2 Tujuan Kegiatan Menambah wawasan tentang Pendidikan PAUD 

untuk pendidik PAUD yang belum mengikuti 

Diklat tingkat dasar. Mengetahui kompetensi-

kompetensi yang dibutuhkan oleh pendidik PAUD 

dalam melaksanakan pembelajaran. 

3 Bentuk Kegiatan Mendampingi dan membantu pamong SKB 

Sleman dalam kegiatan Diklat. Kegiatan 

dilaksanakan di Aula SKB  Sleman, menjadi PDD 

dalam kegiatan dan membantu persiapan konsumsi 

untuk kegiatan. 

4 Sasaran Kegiatan Pendidik PAUD se kabupaten Sleman 

5 Tempat Kegiatan Aula SKB Sleman dan Pondok Pesantren Darul 

Ilmi. 

6 Waktu Kegiatan 11 Agustus 2014 s.d 23 Agustus 2014 

Setiap hari senin-sabtu, sesuai dengan jadwal yang 

telah tersedia. 

7 Hasil Kegiatan Peserta diklat memiliki pengetahuan baru tentang 

PAUD, diharapkan dpat dikembangkan dan 

disalurkan dalam proses pembelajaran maupun 

diluar proses pembelajaran. Peserta yang 

mengikuti diklat berjumlah 90 peserta perwakilan 

dari setiap PAUD yang ada di Kabupaten Sleman. 

8 Biaya Kegiatan - 

9 Faktor Pendukung Terjalinnya komunikasi dan adanya hubungan 

timbal balik antar peserta maupun penyelenggara 

selama pelaksanaan diklat, sehingga mudah untuk 

diajak berkoordinasi. 

10 Faktor Penghambat Ruangan yang digunakan berupa aula, sehingga 

suara menjadi menggema dan peserta sibuk sendiri 

atau berbicara sendiri ketika pembicara sedang 

menyampaikan materi. 

11 Jumlah Jam 59,5 Jam 



 

 Kursus Manajemen Rumah Tangga (KMRT) 

No. ITEM PENJELASAN 

1 Nama Kegiatan Pendampingan Kursus Manajemen Rumah Tangga 

2 Tujuan Kegiatan Mendampingi dan membantu pamong SKB 

Sleman dalam kegiatan Kursus 

3 Bentuk Kegiatan Proses Pendampingan dilakukan di Aula SKB 

Sleman, menjadi PDD dalam kegiatan dan 

membantu persiapan konsumsi untuk kegiatan. 

4 Sasaran Kegiatan Ibu-ibu PKK se Kecamatan Berbah 

5 Tempat Kegiatan  Aula SKB Sleman. 

6 Waktu Kegiatan 26 Agustus 2014 s.d 29 Agustus 2014 

7 Hasil Kegiatan Peserta kursus berlatih menghias toples dan barang 

pecah belah dan membuat masakan yang berupa 

akar kelapa. 

8 Biaya Kegiatan - 

9 Faktor Pendukung Kegiatan telah dipersiapkan sebelum kursus akan 

diselenggarakan, sehingga kegiatan dapat berjalan 

lancar. 

10 Faktor Penghambat Peserta yang datang terlambat dan kurangnya 

koordinasi yang dilakukan antara pemerintah desa 

dengan lembaga atau pihak terkait. 

11 Jumlah Jam 25,5 Jam 

  

2.  Program PPL Kelompok dan Individu Tambahan 

 Penataan Perpustakaan SKB 

No. ITEM PENJELASAN 

1 Nama Kegiatan Penataan Perpustakaan SKB 

2 Tujuan Kegiatan a. Agar Peserta Didik mudah untuk mencari buku 

yang akan digunakan dalam proses 

pembelaaran. 

b. Agar Perpustakaan rapi dan indah di pandang. 

3 Bentuk Kegiatan Mahasiswa PPL membersihkan dan merapikan apa 



yang ada di dalam perpustakaan SKB agar terlihat 

indah dan peserta didik mudah dalam mencari 

buku pelajaran yang akan digunakan. 

4 Sasaran Kegiatan Sasaran dari program ini yaitu Mahasiswa PPL 

UNY 2014 

5 Tempat Kegiatan Perpustakaan SKB Sleman 

6 Waktu Kegiatan 4 Juli 2014 

7 Hasil Kegiatan Perpustakaan SKB menjadi rapi dan indah 

sehingga peserta didik mudah mencari buku 

pelaaran yang akan digunakan. 

8 Biaya Kegiatan - 

9 Faktor Pendukung - 

10 Faktor Penghambat - 

11 Jumlah Jam 3 Jam 

 

 Penghijauan SKB 

No

. 

ITEM PENJELASAN 

1 Nama Kegiatan Penghijauan SKB 

2 Tujuan Kegiatan Membuat tampilan halaman SKB agar lebih indah 

dan segar 

3 Bentuk Kegiatan Mengganti tanaman yang sudah layu dan 

menambahkan tanaman baru. 

4 Sasaran Kegiatan Halaman SKB. 

5 Tempat Kegiatan SKB Sleman. 

6 Waktu Kegiatan 1 September 2014 

7 Hasil Kegiatan Halaman SKB terlihat lebih indah dan segar. 

8 Biaya Kegiatan Rp 120.000,- 

9 Faktor Pendukung - 

10 Faktor Penghambat - 

11 Jam 14 Jam 



 

 Open House SKB 

No. ITEM PENJELASAN 

1 Nama Kegiatan Open House SKB 

2 Tujuan Kegiatan Agar seluruh pamong berkumpul dan 

bersilaturahmi bersama. 

3 Bentuk Kegiatan Kegiatan yang dilakukan adalah mempersiapkan 

tempat untuk open house dan membantu mendekor 

serta membantu menyiapkan konsumsi untuk 

acaranya. 

4 Sasaran Kegiatan Pamong SKB Sleman dan Binaan SKB Sleman 

5 Tempat Kegiatan Sanggar Kegiatan Belajar (SKB) Sleman 

6 Waktu Kegiatan 05 Agustus 2014 

7 Hasil Kegiatan Seluruh Pamong SKB berkumpul semua dan acara 

berjalan lancar 

8 Biaya Kegiatan - 

9 Faktor Pendukung - 

10 Faktor Penghambat - 

11 Jumlah Jam 5 Jam 

 

 Syawalan SKB 

No. ITEM PENJELASAN 

1 Nama Kegiatan Syawalan SKB 

2 Tujuan Kegiatan Bersilaturahmi dengan Pamong SKB  

3 Bentuk Kegiatan Mahasiswa PPL bersilaturahmi dan meminta maaf 

dalam rangka Hari Raya Idul Fitri. 

4 Sasaran Kegiatan Pamong SKB Sleman 

5 Tempat Kegiatan SKB SLeman 

6 Waktu Kegiatan 04 Agustus 2014 

7 Hasil Kegiatan Mahasiswa dan Pamong saling bersilaturahmi dan 

memaafkan. 



8 Biaya Kegiatan - 

9 Faktor Pendukung - 

10 Faktor Penghambat - 

11 Jumlah Jam 0,5 Jam 

  

 Mural SKB 

No. ITEM PENJELASAN 

1 Nama Kegiatan Mural SKB 

2 Tujuan Kegiatan Menambah keindahan serta merapikan halaman 

SKB. 

3 Bentuk Kegiatan Mengecat pagar, membersihkan genteng dan 

menyapu halaman. 

4 Sasaran Kegiatan - 

5 Tempat Kegiatan Di SKB Sleman 

6 Waktu Kegiatan 21,22 juli 2014 

7 Hasil Kegiatan SKB menjadi indah dan rapi 

8 Biaya Kegiatan Rp 600.000 

9 Faktor Pendukung - 

10 Faktor Penghambat - 

11 Jumlah jam 5 jam 

 

 Mural KB Miftahul Jannah 

No. ITEM PENJELASAN 

1 Nama Kegiatan Mural KB Miftahul Jannah 

2 Tujuan Kegiatan Menambah keindahan serta merapikan halaman 

SKB. 

3 Bentuk Kegiatan Mengecat dinding luar KB. 

4 Sasaran Kegiatan - 

5 Tempat Kegiatan KB Miftahul Jannah 

6 Waktu Kegiatan 17-21 Juli 2014 



7 Hasil Kegiatan KB Miftahul Jannah menjadi indah dan rapi 

8 Biaya Kegiatan Rp 200.000 

9 Faktor Pendukung - 

10 Faktor Penghambat - 

11 Jumlah jam 16,5 jam 

 

 Pelatihan Komputer Dasar Paket C 

No. ITEM PENJELASAN 

1 Nama Kegiatan Pelatihan Komputer Dasar Paket C 

2 Tujuan Kegiatan Mendampingi dan membantu peserta didik Paket C 

dalam belajar computer 

3 Bentuk Kegiatan Belajar mengoperasikan komputer dan 

mengerjakan tugas yang telah disediakan. 

Memberikan informasi dan pemahaman tentang 

simbol-simbol yang ada di monitor. 

4 Sasaran Kegiatan Peserta didik Paket C di SKB Sleman 

5 Tempat Kegiatan Ruang Komputer SKB Sleman 

6 Waktu Kegiatan 4 September 2014 

7 Hasil Kegiatan Pelatihan komputer dasar diisi dengan belajar 

mengetik dan mengoperasikan Ms. Word terlebih 

dahulu, karena sebagian peserta didik belum dapat 

menguasai komputer. Sehingga materi yang 

diberikan masih bertingkat dasar, peserta antusias 

dalam mengikuti  pelatihan karena tidak terpaku 

pada buku dan kelas. 

8 Biaya Kegiatan Mahasiswa 

9 Faktor Pendukung Perangkat komputer yang sudah tersedia dan siap 

pakai. Peserta yang sebagian sudah dapat 

mengoperasikan komputer membantu dalam 

mendampingi peserta yang belum dapat 

mengoperasikan komputer. 

10 Faktor Penghambat Perangkat komputer terbatas dan usia peserta yang 

berbeda-beda sehingga dalam menjelaskan materi 



harus diulang. 

11 Jumlah Jam 4 Jam 

 

 September Ceria dan Perpisahan 

No. ITEM PENJELASAN 

1 Nama Kegiatan September Ceria 

2 Tujuan Kegiatan Agar seluruh peserta didik dari KB Binaan SKB 

bisa berkumpul dan berlomba. Selain itu acara ini 

juga sekaligus sebagai acara perpisahan 

Mahasiswa PPL dengan SKB Sleman dan Binaan 

SKB Sleman. 

3 Bentuk Kegiatan Dalam kegiatan ini, kegiatan yang dilakukan antara 

lain lomba mewarnai, lomba fashion show, serta 

pentas seni dari masing-masing KB Binaan SKB 

Sleman dan acara makan-makan dalam rangka 

perpisahan Mahasiswa PPL. 

4 Sasaran Kegiatan Seluruh KB Binaan SKB Sleman 

5 Tempat Kegiatan Di SKB Sleman 

6 Waktu Kegiatan 16 juli 2014 

7 Hasil Kegiatan Acara berlangsung sangat meriah, anak-anak juga 

merasa senang dengan diadakannya acara 

September Ceria ini. 

8 Biaya Kegiatan Rp 1.950.000 

9 Faktor Pendukung - Pihak SKB memberikan support yang bagus 

dalam kegiatan September Ceria ini sehingga acara 

bisa beralan dengan lancar. 

10 Faktor Penghambat - Karena sasaran merupakan anak-anak, adi 

untuk pengkondisian saat acara sangat repot, 

sehingga memerlukan bantuan dari orang tua 

peserta untuk mengkondisikan anaknya. 

11 Jumlah jam 27 jam 

 

 

 



4 Analisis Hasil Pelaksana dan Refleksi 

Program Pelaksanaan PPL sudah telah terlaksana selama kurang lebih dua 

setengah bulan yang bertempat di SKB Sleman, banyak sekali pengalaman yang 

didapatkan, setelah melaksanakan berbagai macam program pendampingan seperti 

TPA Tunas Harapan, KB Miftahul Jannah, Komputer dan berbagai macam 

Pelatihan menjadikan itu semua sebagai tolak ukur, sejauh mana mahasiswa dapat 

menerapkan ilmu secara praktik setelah di dapatkan melalui interdisipliner 

diperkuliahan, terlepas dari hal tersebut banyak sekali permasalahan seiring 

berjalan dengan pelaksanaan PPL berlangsung, maka dari itu  pemamparan 

berbagai macam pengalaman serta permasalahan  mahasiswa selama mengikuti 

PPL ini terangkum sebagai berikut : 

a. Pengalaman  

1. Kemampuan mahasiswa bekerjasama  dengan pamong dan pendidik PAUD 

berlangsung dengan cepat dan baik. 

2. Para pendidik PAUD atau Pamong merasa terbantu dengan kehadiran PPL. 

3. Dapat menemukan pembelajaran baru mengenai mendidik anak-anak PAUD. 

4. Lebih mengetahui secara nyata tentang program-program Ke-PLSan 

b. Hambatan  

1.  Pengaruh tentang kinerja mahasiswa yang belum maksimal dalam 

melaksanakan PPL karena bersamaan dengan KKN yang lokasinya terspisah 

dengan PPL. 

2. Lokasi PAUD binaan yang terletak cukup jauh dari SKB Kabupaten Sleman 

mengakibatkan rasa capek dan waktu habis di perjalanan. 

3. Penyesuaian program dan pembagian waktu yang dapat dikatakan belum 

efektif dan efisien. 

3. Anggaran dana yang minim, sehingga pemasukan dan pengeluaran tidak 

sebanding.  

Dari beberapa pengalaman serta penghambat tersebut, menjadikan 

pembelajaran baru yang didapatkan, karena pengalaman yang diperoleh dijadikan 

sebagai pondasi dasar sebelum masuk pada dunia kerja dan permasalahan yang 

didapatkan selama proses PPL ini berlangsung menjadikan penghayatan bagi 

mahasiswa dalam mengahadapi permasalahan yang akan lebih mengerti 

bagaimana menghadapi masalah tersebut dengan bijak. Oleh karena itu, PPL ini 

menjadikan mahasiswa lebih berkomitmen dan bertanggung jawab dengan apa 

yang dipilih dan dilakukannya pada nantinya. 

 

 

 

 

 



BAB III 

PENUTUP 

 

A. KESIMPULAN 

Usaha peningkatan efisiensi dan kualitas penyelenggaraan proses 

pembelajaran terus dilakukan, termasuk dalam hal ini mata kuliah lapangan 

seperti Mata Kuliah Praktik Pengalaman Lapangan (PPL). Penyusunan laporan 

ini merupakan akhir dari program Praktek Pengalaman Lapangan yang 

dilaksanakan di Sanggar Kegiatan Belajar (SKB) Sleman Kabupaten Sleman. 

Selama melaksanakan PPL, praktikan mempunyai banyak pengalaman yang 

dapat disimpulkan sebagai berikut : 

1. Program Pengalaman Lapangan (PPL) Sebagai salah 

satu program wajib yang harus ditempuh sebagai langkah awal sebelum 

terjun kedunia kerja, PPL ini akan memberikan banyak sekali pembelajaran 

dengan tujuan mahasiswa dapat mendapatkan ilmu langsung secara praktik 

dilapangan. 

2. PPL akan memberikan kesempatan untuk berkreasi dan 

berinovasi sesuai dengan kemampuan yang dimilikinya, dengan 

kesempatan itu dapat meningkatkan kualitas SDM yang lebig baik dalam 

lembaga atau instansi ataupun masyarakat secara luas. 

3. Menjadikan mahasiswa lebih bertanggung jawab 

melalui pelaksanaan program, baik itu program indidual maupun secara 

kelompok 

4. Menumbuhkan kolektivitas antar teman kelompok dan 

dapat memberikan pengalaman bekerjasama dengan orang-orang baru baik 

itu dengan  Pamong maupun dengan peserta didik PAUD. 

5. Dengan program PPL, mahasiswa sebagai calon 

pendidik akan lebih siap terjun ke dunia kerja dan dengan bekal 

pengalaman menjadikan sebagai pondasi yang kuat untuk bersaing di dunia 

kerja. 

B. SARAN 

1. Pihak lembaga 

 Dalam meningkatkan kualitas pendidikan dan SDM, lembaga terkhusus 

lembaga SKB dapat bekerja sama dengan para mahasiswa dalam 

pengembagan pendidikan dan SDM terlebih melalui program-program yang 

inovatif. Selanjutya lebih menjamin kualitas PAUD binaan baik itu masalah 

materi ataupun non materi, karena dengan PAUD binaan tersebut dapat 

menyentuh masyarakat bawah dalam pengembangan pendidikan dan kualitas 

SDM mereka. 

 



2. Pihak Universitas Negeri Yogyakarta 

Upaya peningkatan mutu mahasiswa  UNY tidak hanya dilakukan program 

PPL saja, akan lebih baik program praktik lebih diperkenalkan semenjak 

semester awal, dengan upaya antara mahasiswa dan lembaga dapat terjalin 

kerja sama dalam kurun waktu yang ditentukan. 

3. Mahasiswa  

Mahasiswa selanjutnya yang akan melakukan PPL seharusnya semester awal 

sudah mempersiapkan diri untuk terjun ke lapangan, diwajibkan untuk 

menemukan inovasi baru terutama dalam jurusan Pedidikan luar sekolah, 

karena dalam pengembagan pendidikan dan SDM jurusan Pendidikan luar 

sekolah melalui lembaga SKB masyarakat bisa tersentuh sampai garis 

terbawah. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

LAMPIRAN 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 
 

MATRIK PROGRAM KERJA PPL UNY 
 

 
 

TAHUN : 2014 
   

 
         

FO1     

Universitas Negeri Yogyakarta 

        
Kelompok Mahasiswa 

 

  

             
 

             
 NOMOR LOKASI : 

           
 NAMA SEKOLAH/ LEMBAGA : UPTD SKB SLEMAN 

     
 ALAMAT SEKOLAH / Lembaga : JL. Kalitirto, Berbah, Sleman 

    

              

              

No Program/Kegiatan PPL 

Jumlah Jam Per Minggu Jumlah 

Total Juli Agustus September 

1 2 3 4 1 2 3 4 1 2 3   

1 Mengajar Paket C                         

  a. Persiapan                         

  b. Pelaksanaan                         

  c. Evaluasi                         

2 

Pendampingan TPA Tunas 

Harapan                         

  a. Persiapan                         

  b. Pelaksanaan     9,5   4   20 2 16 20   71,5 

  c. Evaluasi                         

3 Pendampingan TK Tunas Harapan                         

  a. Persiapan   8                   8 

  b. Pelaksanaan                   6   6 

  c. Evaluasi                         

4 Pendampingan KB Tunas Harapan                         

  a. Persiapan   3                   3 

  b. Pelaksanaan     7,5     3,5 6,5     2,5   20 

  c. Evaluasi                         

5 

Pendampingan KB Miftahul 

Jannah                         

  a. Persiapan                         

  b. Pelaksanaan           3,5   4,5 4,5     12,5 

  c. Evaluasi                         

6 Pelatihan Komputer Dasar                         

  a. Persiapan                 2     2 

  b. Pelaksanaan                 2     2 

  c. Evaluasi                         

7 Penghijauan SKB                         

  a. Persiapan               4       4 

  b. Pelaksanaan                 10     10 

  c. Evaluasi                         

8 Senam Sehat                         

  a. Persiapan                         

  b. Pelaksanaan                         

  c. Evaluasi                         

9 Lomba Mewarnai                         

  a. Persiapan                         

  b. Pelaksanaan                         

  c. Evaluasi                         



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  PROGRAM TAMBAHAN                         

10 Observasi dan Koordinasi Program                         

11 Mural KB Miftahul Jannah     15 7 9,5             16,5 

12 Penataan Perpus SKB 3                     3 

13 Mural SKB       5               5 

14 Syawalan         0,5             0,5 

15 Open House         5             5 

16 

Diklat Pendidik PAUD Angkatan 

II           39,5           39,5 

17 

Diklat Pendidik PAUD Angkatan 

III             20         20 

18 Diklat KMRT               25,5       25,5 

19 September Ceria                 3 10 14 27 

  Jumlah Jam                       281 

              

 
Mengetahui, Menyetujui 

            

              

 
Kepala  Dosen Pembimbing Lapangan Yang membuat, 

UPTD SKB Sleman 
            

              

              

 
(Drs. Yunaidi) 

 
(Dr.Sujarwo, M.Pd) 

 
(Aji Samanta K N) 

 
NIP. 196205281986021004 

 
NIP. 19691030 200312 001 

 

NIM. 11102244022 



PANDUAN KEGIATAN PELATIHAN KOMPUTER 

 

Materi  : Mengatur halaman kerja dan Membuat Surat menggunakan aplikasi 

Microsoft Word 

Sasaran : Warga Belajar Paket C SKB Sleman 

Waktu  : 2 Jam 

Tempat : Ruang Komputer SKB Sleman 

 

A. MENGATUR LEMBAR KERJA 

Perlu dilakukan pengaturan ruang kerja di lembar kerja anda, hal ini 

membantu dalam aktivitas pengetikan dan pengeditan lembar kerja. Beberapa hal 

utama yang perlu dilakukan adalah : 

 

1. Untuk memudahkan pengetikan di lembar kerja, munculkan “Ruler” dengan cara 

klik menu View > kemudian klik Ruler. 

2. Untuk memudahkan pengukuran dokumen kerja anda, diperlukan merubah 

pengukuran dari inchi ke centimeter. Klik File > Option > Advanced 

 

 

 

Lalu menuju ke Display di bagian Advanced (di bawah) dan pilih di “Show 

measurements in units of” pilih Centimeters. 

3. Secara default Word mengaktifkan menu untuk membantu agar tidak muncul garis 

merah dan garis hijau di lembar kerja, klik menu Review > Spelling&Grammar. Lalu 

muncul kotak dialog: 



 

 

Klik tombol Option. Lalu muncul kotak option di bawah ini: 

 

 

 

Kemudian hilangkan tanda centang pada “Check spelling as you type” dan “Mark 

grammar error as you type”. 

 

4. Langkah selanjutnya anda harus mengatur ukuran kertas, klik Page Layout > Size, 

lalu pilih jenis kertas yang sesuai. Pilih ukuran standar kertas A4, seperti di bawah 

ini: 

 



 

5. Kemudian atur margin lembar kerja yang merupakan pengaturan batas kiri, kanan, 

atas dan bawah kertas. Klik Page Layout > Custom Margins. 

 

 

Lalu isikan dengan nilai berikut: Top: 3cm, Left: 4cm, Bottom: 3cm, Right: 2cm. 

Lalu klik OK. 

 

 

6. Langkah terakhir adalah mengatur spasi baris, pada menu home 

 

 



 

 

B. MEMBUAT SURAT 

1. Mengetik surat di lembar kerja yang sudah di atur halamannya sebelumnya 

2. Setelah selesai mengetik dokumen di atas pastikan rapi dan pastikan telah 

anda pilih rata kanan dan penomoran yang benar. Untuk melihat apakah hasil 

kerja anda bagus, bisa menekan CTRL+SHIFT+8, untuk mengetahui karakter-

karakter yang kemungkinan kurang tepat dalam dokumen. 

3. Setelah itu surat bisa di save kemudian siap untuk di print dan digunakan. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



PENGHIJAUAN SKB 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



DIKLAT KMRT 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



DIKLAT PENDIDIK PAUD 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



CATATAN HARIAN 

















 


